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Overview

Congratulations and welcome to FTD Mercury! FTD Mercury is a complete Windows-based 
business tool that allows you to communicate easily with other florists and FTD Headquarters 
through the Mercury Network. FTD Mercury also automates other areas of your store, such as your 
customer database and the products you sell in your store.

FTD Mercury allows you to:

» Send and receive Mercury orders and messages (see Mercury Messages on page 4–1)

» Store all incoming and outgoing Mercury orders and messages in a message log (see Message 
Center on page 4–3)

» Reconcile wire orders (see Wire Service Reconciliation on page 17–1)

» Search for and reply to Mercury messages (see Searching for Mercury Messages on page 4–2)

» Perform faster and easier florist and facility searches (see Searching for Florists on page 5–3 and 
Facility Search on page 5–13)

» Create customer and product databases (see Customer Maintenance on page 7–1 and Product 
Maintenance on page 8–1)

» Maintain your employees with different access levels to the program (see Security on page 6–6)

» Use Microsoft Office to merge customer and recipient information for direct mail and 
marketing purposes (see Mercury Marketing on page 15–1)

» Create and maintain customer house accounts—including printing, emailing, and faxing 
statements (see Setting Up House Accounts on page 7–23) 

» Process orders through Order Entry and Point of Sale (see Working with Orders on page 9–1)

» Process orders and manage your cash drawer through Point of Sale (see Managing Point of Sale 
Sessions on page 11–1)

» Confirm deliveries with email delivery confirmation (see Sending Delivery Confirmation Email 
Messages on page 9–73)

» Maintain customer credit cards and perform settlements on credit card transactions (see 
Processing and Settling Credit Cards on page 13–1)

» Automate billing functions and print customer statements (see Accounts Receivable on page 
18–1)

» Export general ledger files to third party accounting software (see Accounting Application and 
QuickBooks Integration on page 20–1 and Legacy General Ledger Module on page 21–1)

» Create and maintain delivery routes (see Creating Delivery Routes on page 14–12)

» Extract your customer information to create direct mail or email marketing campaigns (see 
Mercury Marketing Module on page 16–1)
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» And much more!

About This Reference Guide
Learning a new computer program requires patience and practice. The goal of this reference guide 
is to introduce you to key learning concepts of the FTD Mercury software and provide follow-up 
guidelines while you are learning.

The FTD Mercury Reference Guide is organized by chapters. This reference guide has been designed 
with numerous procedures to walk you through common tasks.

Documentation Conventions
This reference guide uses the following conventions for describing system navigation.

Resources for Help
If you have an FTD Mercury usability issue, the following resources may be helpful to you:

» If you want to know what’s new from the previous release, see your FTD Mercury New and 
Enhanced Features Guide.

» Check the Table of Contents and/or Index of this guide for the topic for which you need 
assistance. A shortcut to the manual is also available on your computer’s desktop (double-click 
the FTD Mercury Manual icon).

» Use FTD Mercury Online Help to search for your topic. On the Help menu, click Contents. See 
Using Online Help for more information.

» Press F1 to display a help page. F1 help pages are available in most areas of the program and 
are useful when you need help in a particular window. 

» Use FTD Mercury field help. If you need help with a particular field, right-click on that field to 
display help text, or in a text field, press Ctrl and F1 simultaneously while your cursor is in that 
field.

Using FTD Mercury Help
Welcome to the FTD Mercury F1 Help system! This help system has been designed to walk you 
through procedures within a particular program window. If you find yourself “stuck” in a particular 
window and don’t know what to do next, press F1 and a help page will appear to help you along!

Table 1-1: System Navigation Conventions

When you see this… Do this…

On the File menu, click New 
Customer.

Click the word File on the menu bar, then click the words New 
Customer from the menu that appears.

Click Send. Click the Send button

Click . Click the on-screen calculator button.
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There have been three help systems designed to help you while you are learning your new FTD 
Mercury program:

» F1 Help is designed to help you if you are ‘stuck in a particular window. Just press F1 in any 
window!

» The Online Help system is designed like an online manual. It is accessed by selecting Contents 
from the Help menu. This help system contains a Contents tab (table of contents), Index tab (to 
select keywords from a list), a Find tab (to search for help pages that contain a keyword you 
provide), and a Favorites tab (to allow you to save pages you want to return to later).

» The FTD Mercury field level help displays help for a particular field. Just right click on any field 
or press and hold the Ctrl key when your cursor is in that field and then press F1. A brief 
explanation of that field will display.

Don’t Forget Your Other Resources for Help!
Your FTD Mercury Reference Guide is a complete manual to learning your FTD Mercury system. Use 
the Table of Contents and Index to find your help topic.

Your FTD Mercury Quick Reference Guide (available as a PDF on your desktop) will help you when you 
are first learning.

FTD Mercury support is available through a GENeral message at 90-5034AA or telephone at 1-888-
681-7911. You may speak to a live representative Monday through Friday from 7 A.M. to 7 P.M. or 
Saturday from 7 A.M. to 6 P.M. Central Time. 

Using Online Help
Online help is a quick, easy way to find answers. To access online help, on the Help menu click 
Contents.

The Contents, Index, Search, and Favorites Tabs
The FTD Mercury Online Help system consists of three tabs to help you find information: Contents, 
Index, and Search. An additional fourth tab, Favorites, allows you to store pages you want to access 
later.

The Contents tab appears when you open the help program. It consists of a series of books and 
pages. Pages are represented by the  icon. Pages contain the information you are looking for – 
general information, procedures, and tips. 

When the help program opens, all books are closed:

Figure 1-1: Help Books (Closed).

If you double-click on a book, it displays the contents of that book:

Figure 1-2: Help Books (Opened)

Click on the page that contains the information you are looking for and the help topic displays.
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The Index tab allows you to enter keywords to find the information you are looking for. Enter a 
keyword, and the topic that best represents your keyword is highlighted. Double-click on that topic 
to display its contents.

The Search tab finds all topics in the help program that contain the keyword you enter. It finds all 
topics that include your keyword somewhere in the text. 

When selecting a keyword in either the Index or Search tabs, there may be multiple help topics 
that fit that keyword. In this case a popup window displays and allows you to select a topic to 
display. For example, if you click the “Products” keyword, the system allows you to choose a specific 
topic to display.

Figure 1-3: Multiple Help Topics Found

Highlight the topic that you want to display, then click the Display button.

Hyperlinks and Breadcrumbs
Many pages in FTD Mercury Online Help contain hyperlinks. These are underlined words that, when 
clicked, take you to other related pages.

On the top of each page, special hyperlinks called breadcrumbs are provided to allow you to see 
where the page fits within the help system structure. Click on these links to “back up” a level to a 
more general topic.

FTD Mercury Technical Support
If you cannot find the answer to your question through the resources listed in this chapter, call the 
Mercury Technology Assistance Center Monday through Friday from 7am to 7pm or Saturday from 
7am to 6pm Central Time at 1-888-309-2244. You may also send a GENeral Message to 90-5034AA. 

Other Important Phone Numbers
» FTD Member Services: 1-800-669-1000

» Mercury Technology Sales: 1-800-767-3222

Flowers All Hours
Flowers All Hours (FAH) is a service which provides Members’ stores and customers with 24-hour 
telephone service.
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Once you sign up for this service, any time you need assistance during a hectic day, or when you’re 
ready to close for the night, simply activate the “Call Forward” feature on your phone. This will 
transfer your incoming calls to FTD Flowers All Hours.

Trained FTD representatives answer your calls promptly and courteously, using your store name. 
They’ll use your customized product and pricing information to assist callers and to take accurate 
orders. All the information, including customer name, address, phone number, special instructions 
and payment information is forwarded to you via the FTD Mercury® Network. When the rush is over, 
or when you open again in the morning, your orders and messages will be waiting for you on your 
Mercury system.

To get started, call 1-800-669-1000, or send a GEN message to 90-9200AA.

Florists Online
With the increase in the number of consumers who purchase on the Internet, FTD members find it 
necessary and important to the future growth and success of their business to invest in a high-
quality, secure Web Site.

With a Florists Online Web Site, you can reach millions of new customers and sell your entire store’s 
product selection to online customers around the world and receive the order fulfillment 
information via the Mercury Network.

You don’t even need a computer or Internet access—it’s that simple!

For more information, please call 1-800-576-6721 Monday-Friday 8:30 A.M.–5 P.M. Central Time to 
speak to an FTD Florists Online Internet Service Representative, or send a Mercury GENeral 
message to 90-8418AA, or email us at floristsonline@ftdi.com and we’ll be happy to assist you!

FTD Flower Exchange
The FTD Flower Exchange is a FREE & EXCLUSIVE online fresh flower buying platform designed to 
provide options to our members for their floral needs. We have partnered with the BEST growers 
and BEST logistics companies around the world to provide FTD members the very best floral 
purchasing solutions for their businesses. We are leveraging the buying power of thousands of 
florists to bring the BEST possible prices all year long.

Expansive Selection from Best Growers Around the World

Quality is our number one priority. The FTD Flower Exchange grower partners are continually 
monitored and inspected to insure the best quality products are available to FTD members all year 
long. All of our partners are identified by the brands you trust and include Rio Roses, Esmeralda, 
Sun Valley, Passion Growers, Dos Gringos, Sole’, Benchmark, Dole and more. Every day we offer 
access to 4,000+ of the best products from South America, Holland, Central America and California.

Professional & Experienced Team

FTD has invested in an experienced team of Procurement, Logistics, Sales and Support 
professionals that are 100% dedicated to the fresh flower needs of FTD members. Our team works 
regularly with florists of all sizes to develop floral programs tailored to meet the needs of each 
business. Whether it is custom boxes, standing orders, logistics solutions or holiday purchases our 
team can save you time and money.
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Convenient, Reliable, and Flexible

Our state of the art web site is open for business 24 hours a day, 7 days a week and 365 days a year. 
The online buying platform provides visibility to ‘just-in-time’ inventory, prebook availability and a 
full purchase and pricing history. Additionally, florists can purchase directly from over 30 of the 
best growers around the world on one consolidated order that can be added to their FTD 
Clearinghouse Statement or charged to a credit card. 

Customized Purchasing and Logistics Solutions
Delivery options include Federal Express, DHL, air freight and refrigerated delivery. The all new 
BUILD A BOX program is exclusive to FTD Members. For the first time, FTD florists can custom pack 
their own boxes at the farm level. It is truly unique and gives florists the ability to purchase based 
on what makes sense for their business.

Daily, Weekly, Event, and Holiday Promotions
Our procurement team works with growers daily to find the very best deals. The daily and weekly 
HOT BUYS are the products you need at prices you can’t afford to pass up. The holiday specials, 
add-on promotions and standing order discounts are just a few of the programs designed to help 
florists maximize savings.

Contact Us

FTD Flower Exchange is more than just a place for FTD members to purchase their wholesale bulk 
flowers. Contact us today to learn more.

www.ftdflowerexchange.com
ftdflowerexchange@ftdi.com
1-800-767-4000

FTD WebGifts
For a one-time fee of $50, you can enter the multi-billion dollar gift business! 

FTD WebGifts is an inventory-free consumer direct service offering a collection of both floral and 
non-floral gift items for you to sell in your shop or on your web site. You send the orders to FTD via 
your Mercury system and we ship the product directly to the recipient. No inventory and no hassle!  
FTD Members earn normal sending commission plus rebates on every order. 

Participating is as Easy as 1, 2, 3!
1 Enroll and add FTD WebGifts products to your web site 

» Contact your FBC, Call WebGifts Customer Service at 1-800-767-4000, or Email WebGifts 
Customer Service at WebGifts@ftdi.com  

» If you are a Florists Online (FOL) Member, we will coordinate with FOL to have WebGifts 
added to your web site 

» If you host your own web site, we will send you a CD-ROM of images and Suggested Retail 
Prices (SRP's) for you to add 

» All images and SRP's can be found at FTDi.com
2 Promote that you are in the gift business in your marketing materials 

» Utilize FTD WebGifts imprint magnets, imprint catalogs and statement stuffers in your daily 
business 

» Direct people to your site through FOL Local Search, FTD Directory, etc. 
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» There is no inventory to carry and no product to buy!
3 Close the sale and send the orders to 90-0233AA for fulfillment. The vendor will ship the 

product directly to the gift recipient on your behalf with your store’s information. 

» All orders received in the given month will appear on the Members Clearinghouse 
Statement 

» Receive 20% commission (normal sending commission) 

» Earn sending rebates 

» Sent orders count towards members monthly quota

Interflora
Interflora, Inc. is an international clearing house for flower-by-wire orders exchanged between 
Members of the groups comprising Interflora, Inc. For more information about Interflora, call 1-800-
788-9000.
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